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Chapter 835 

Reliability 
Demonstration Tests 
of One Proportion 
Introduction 
This routine calculates the sample size needed for a reliability demonstration test based on the binomial 
distribution. These tests are conducted by calculating a one-sided confidence bound for a proportion and checking 
whether the bound is greater than a pre-determined reliability standard. It may be used to find a sample size and/or 
power for studies of rare events. 

Technical Details 
This procedure is primarily based on results in Guenther (1977) and Hahn and Meeker (1991). Conceptually, the 
test compares a one-sided confidence bound to the reliability standard. However, the sample size formulas are 
based on using an exact binomial test of one proportion.  

A binomial variable should exhibit the following four properties: 

1. The variable is binary --- it can take on one of two possible values. 

2. The variable is observed a known number of times. Each observation or replication is called a Bernoulli trial. 
The number of replications is n. The number of times that the outcome of interest is observed is r. Thus r 
takes on the possible values 0, 1, 2, ..., n. 

3. The probability, P, that the outcome of interest occurs is constant for each trial.  

4. The trials are independent. The outcome of one trial does not influence the outcome of the any other trial. 

A binomial probability is calculated using the formula 
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Following Guenther (1977) define the cumulative binomial as 
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The minimum sample size is found by solving the following two inequalities simultaneously 

𝐵𝐵𝐵𝐵(𝑐𝑐;𝑁𝑁, 1 − 𝑃𝑃𝑀𝑀𝑀𝑀𝑀𝑀) ≤ 𝛼𝛼 

𝐵𝐵𝐵𝐵(𝑐𝑐;𝑁𝑁, 1 − 𝑃𝑃𝑇𝑇𝑇𝑇𝑇𝑇𝑇𝑇) ≥ 𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃𝑃 

where Power  is the probability of a successful demonstration, PMIN is the reliability standard, and PTRUE is the 
reliability value at which Power  is calculated. 

Procedure Options 
This section describes the options that are specific to this procedure. These are located on the Design tab. For 
more information about the options of other tabs, go to the Procedure Window chapter. 

Design Tab 
The Design tab contains most of the parameters and options that you will be concerned with. 

Solve For 

Solve For 
Select the parameter you want to solve for. The parameter you select here will be shown on the vertical axis in the 
plots. 

Sample Size 

A search is conducted for the minimum sample size that adheres to the two inequalities. Remember that the search 
is based on two inequalities, so the particular values of the confidence level and Power are seldom met exactly. 

Power (Prob of Successful Demonstration) 

A search is conducted to find the value of Power for the values of the other parameters. 

Sample Size 

N (Sample Size) 
Enter one or more values for the sample size. This is the number of individuals selected at random from the 
population to be in the study. 

You can enter a single value or a range of values. 
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Alpha and Power 

Alpha 
Specify alpha, the probability of concluding reliability when in fact the object under study is not reliable. 
Reliability is defined as the probability of a success. 

In this procedure, one minus alpha is interpreted as the confidence level of a one-sided confidence bound for the 
reliability. The demonstration test is may be carried-out by comparing a one-sided lower confidence bound of the 
reliability to a specified minimum requirement (Pᴍɪɴ). If the confidence bound is larger than Pᴍɪɴ, reliability is 
demonstrated. 

The demonstration test may also be carried out by noting whether the number of adverse events is less than or 
equal to c, the maximum allowed adverse events. 

Alpha ranges from 0 to 1. Typical values range from 0.2 to 0.001. 

You can enter a single value such as 0.05 or a series of values such as 0.1 0.05 0.01 or 0.05 to 0.20 by 0.01. 

Power 
The power is the probability that the test demonstrates conformance to the reliability standard (Pᴍɪɴ) when the 
object's reliability is actually greater than Pᴍɪɴ. The power is calculated using the cumulative binomial 
distribution with P = Pᴛʀᴜᴇ, the assumed true reliability.  

The range of this parameter is from 0 to 1. Typical values range from 0.8 to 0.999. 

You can enter a single value such as 0.95 or a series of values such as 0.9 0.95 0.99 or 0.8 to 0.95 by 0.01. 

Reliability 

PMIN (Minimum Reliability) 
Enter Pᴍɪɴ, the minimum reliability (proportion of population conforming) that has been set as the standard or 
requirement. 

If the lower confidence bound of the proportion conforming computed from the study is greater than Pᴍɪɴ, 
reliability is demonstrated. Otherwise, it is not. 

The range of this parameter is 0 < Pᴍɪɴ < 0.999999. 

Often, one of the values 0.80, 0.90, 0.95, 0.99, 0.999, or 0.9999 is used. 

You can enter a single value such as 0.9 or a series of values such as 0.9 0.95 0.99 or 0.8 to 0.95 by 0.01. 

PTRUE (True Reliability) 
Enter Pᴛʀᴜᴇ, the assumed true value of the reliability (proportion of population conforming). This is the value of P 
used to calculate power using the binomial probability distribution. 

The range of this parameter is between Pᴍɪɴ and 1. Typical values range from Pᴍɪɴ to 0.9999. 

You can enter a single value such as 0.95 or a series of values such as 0.9 0.95 0.99 or 0.8 to 0.95 by 0.01. 
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Example 1 – Calculating Sample Size  
Suppose a study is planned to determine the sample size required for a reliability demonstration study in which 
Pᴍɪɴ = 0.9, PTRUE = 0.95, 0.99, or 0.999, the significance level is 0.05, and the probability of a successful 
demonstration must be at least 0.95. 

Setup 
This section presents the values of each of the parameters needed to run this example. First load the Reliability 
Demonstration Tests of One Proportion procedure window. You may then make the appropriate entries as 
listed below, or open Example 1 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Alpha ....................................................... 0.05 
Power ...................................................... 0.95 
PMIN ......................................................... 0.9 
PTRUE ....................................................... 0.95 0.99 0.999 

Annotated Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for Reliability Demonstration Test 
Solved for Sample Size 
       Maximum 
Minimum True     Sample Adverse 
Reliability Reliability Target Actual Target Actual Size Events 
Pᴍɪɴ Pᴛʀᴜᴇ Power Power Alpha Alpha N c 
0.9000 0.9500 0.9500 0.9542 0.050 0.049 298 21 
0.9000 0.9900 0.9500 0.9766 0.050 0.049 61 2 
0.9000 0.9990 0.9500 0.9714 0.050 0.047 29 0 
 
References 
Guenther, William C. 1977. Sampling Inspection in Statistical Quality Control. Griffin’s Statistical Monographs, Number 37. London. 
Hahn, G. J. and Meeker, W.Q. 1991. Statistical Intervals. John Wiley & Sons. New York. 
Meeker, W.Q. and Escobar, L.A. 1998. Statistical Methods for Reliability Data. John Wiley & Sons. New York. 
 
Report Definitions 
Minimum Reliability, Pᴍɪɴ, is the reliability standard or requirement. It is the required proportion of the 
   population conforming and is used to calculate alpha. 
True Reliability, Pᴛʀᴜᴇ, is the reliability (proportion conforming) that is assumed to be 'true' and is used to 
   calculate power. 
Power is the probability of rejecting the null hypothesis of unreliability when it is false. In reliability 
   demonstration studies, power is often called the probability of successful demonstration of conformity. It is 
   calculated using Pᴛʀᴜᴇ. 
Target Power is the power the design is meant to achieve. 
Actual Power is the power the design actually achieves. It is calculated using Pᴛʀᴜᴇ. 
Alpha is the significance level of this one-sided test. It is the probability of rejecting the null hypothesis of 
   unreliability when it is true. The demonstration test can be carried-out by comparing a one-sided lower 
   confidence bound of the reliability with a confidence level of one minus alpha to a specified minimum 
   requirement (Pᴍɪɴ). If the confidence bound is larger than Pᴍɪɴ, reliability is demonstrated. The demonstration 
   test can also be carried-out by comparing the number of adverse events to a maximum allowed value, c. 
Target Alpha is the significance level the design is meant to achieve. 
Actual Alpha is the significance level the design actually achieves. It is calculated using Pᴍɪɴ. 
Sample Size, N, is the number of subjects in the study. 
Maximum Adverse Events, c, is the number of nonconforming events that are tolerated while still concluding a 
   successful demonstration. It is sometimes called the 'maximum failures allowed.' 
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Summary Statements 
A test of a single proportion used to demonstrate conformance with a reliability standard 
computed from a sample of 298 observations with a minimum reliability requirement of 0.9000 at 
a 0.050 significance level. The probability that such a study will have a successful 
demonstration is 0.9500 assuming a true reliability of 0.9500. The maximum number of adverse 
events allowed with a successful demonstration is 21. 
 
 
Dropout-Inflated Sample Size 
  Dropout-  
  Inflated Expected 
  Enrollment Number of 
 Sample Size Sample Size Dropouts 
Dropout Rate N N' D 
20% 298 373 75 
20% 61 77 16 
20% 29 37 8 
 
Definitions 
Dropout Rate (DR) is the percentage of subjects (or items) that are expected to be lost at random during the 
   course of the study and for whom no response data will be collected (i.e. will be treated as "missing"). 
N is the evaluable sample size at which the tolerance interval is computed. If N subjects are evaluated out of 
   the N' subjects that are enrolled in the study, the design will achieve the stated tolerance interval. 
N' is the total number of subjects that should be enrolled in the study in order to end up with N evaluable 
   subjects, based on the assumed dropout rate. After solving for N, N' is calculated by inflating N using the 
   formula N' = N / (1 - DR), with N' always rounded up. (See Julious, S.A. (2010) pages 52-53, or Chow, S.C., 
   Shao, J., and Wang, H. (2008) pages 39-40.) 
D is the expected number of dropouts. D = N' - N. 
 

This report shows the calculated sample size for each of the scenarios.  

Plots Section 
 

    
 

This plot shows the sample size versus the three values of PMIN. 
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Example 2 – Validation using Hahn and Meeker (1991) 
Hahn and Meeker (1991) page 171 find the sample size requirements for a reliability demonstration study in 
which Pᴍɪɴ = 0.99, PTRUE = 0.999, the confidence level is 0.9 (alpha = 0.1), and the probability of a successful 
demonstration (power) must be at least 0.95. They calculated a sample size of 531 with c = 2. 

Setup 
This section presents the values of each of the parameters needed to run this example. First load the Reliability 
Demonstration Tests of One Proportion procedure window. You may then make the appropriate entries as 
listed below, or open Example 2 by going to the File menu and choosing Open Example Template. 

Option Value 
Design Tab 
Solve For ................................................ Sample Size 
Alpha ....................................................... 0.1 
Power ...................................................... 0.95 
PMIN ......................................................... 0.99 
PTRUE ....................................................... 0.999 

Output 
Click the Calculate button to perform the calculations and generate the following output. 

Numeric Results 
 

Numeric Results for the Reliability Demonstration Test 
Solved for Sample Size 
       Maximum 
Minimum True     Sample Adverse 
Reliability Reliability Target Actual Target Actual Size Events 
Pᴍɪɴ Pᴛʀᴜᴇ Power Power Alpha Alpha N c 
0.9900 0.9990 0.9500 0.9832 0.100 0.100 531 2 
 

PASS has also calculated the sample size as 531 and c = 2. 
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